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I. Introduction to Web Accessibility 

In May 1999, the World Wide Web Consortium (W3C) introduced its Web 
Content Accessibility Guidelines (WCAG) 1.0. The WCAG outlines steps 
that Web-site owners can take in order to make their sites usable by 
persons with disabilities such as low vision, color-blindness, and limited 
mobility. If a Web site fails to conform to the WCAG, a portion of your 
constituents and visitors may not be able to understand the site's content. 
 
This tutorial explains how to test your Web site for a number of common, 
high-level accessibility problems. Section II describes six visual tests 
Webmasters can use to check their sites for accessibility and explains how 
to download, install, and use Job Access With Speech (JAWS), a screen 
reader used by visitors who are blind or partially sighted. Section III 
explains how to use and understand the Web Accessibility Versatile 
Evaluator (WAVE), a Web site that tests HTML code for accessibility errors. 
 
While the testing tools used in this tutorial cost nothing, the following 
equipment and materials are necessary: 

     ● A computer that runs Windows XP or 2000 operating systems with at 
        least 200 MB of free hard-drive space. The computer should also have    
        either audio outputs for connecting speakers or a headphone jack. 

     ● Microsoft Internet Explorer version 6.0. 

     ● Computer speakers or a pair of headphones. 

     ● A means of documenting test results. 
 
Note that while this tutorial explains how to perform accessibility testing, it 
does not cover methods to fix all detected problems. To fix detected 
accessibility problems, your organization should consult with a professional 
Web developer or conduct additional research.  
 
Editor's Note 1: This tutorial provides instructions for accessibility testing 
using Internet Explorer. Mozilla Firefox users can also use this tutorial to test 
their sites, although some of the menu items will be different. 
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II. Front-End Web Accessibility Testing 

When testing a Web site for accessibility, start by checking the site's front-
end elements, those items that users can see or hear. This section provides 
step-by-step instructions for performing six visual tests and one audio test. 
 
A. Visual Accessibility Tests 

To evaluate a Web site's content and design for accessibility, perform the 
following six visual tests. 
 
Test #1:  Ensure that link text is descriptive. 

To ensure that links are meaningful to visitors who are using a screen-
reading program, Web designers should make all link text as descriptive as 
possible. To do this: 
 
Step 1. Open Internet Explorer. 
 
Step 2. Enter the URL of the Web page you wish to test. 
 
Step 3. Visually scan the site for links, which appear as underlined text, 

and read the sentences in which they appear. Example 1 
demonstrates the type of language that fails to comply with 
accessibility guidelines, while Example 2 corrects the problem.  

 
 ● Example 1:  To learn more about Web accessibility, click here. 
 
 ● Example 2:  To learn more about Web accessibility, read  
                                   the article "How to Test a Web Site For Accessibility."            
 
Step 4. Repeat Steps 2 and 3 for each page on the Web site. 
 
Test #2:  Ensure that all images contain alt text. 
Alternate text (often abbreviated "alt text") describes images or graphics 
on a Web page. To help visitors who are blind or have low vision 
understand which images appear on your Web page, ensure that all 
graphics contain alt text. To do this: 
 
Step 1. Open Internet Explorer. 
 
Step 2. Click the Tools menu item, located in the upper-left corner of the   
              browser window. A drop-down menu appears. 
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Step 3.  From the drop-down menu, click the Internet Options menu item.  
              A small window appears. 
 
Step 4.  Click the Advanced tab and scroll to the Multimedia subheading.  
              Uncheck the box labeled Show Pictures. 
 
Step 5.  Close Internet Explorer and reopen it. 
 
Step 6.  Type the URL of the Web site you wish to test. 
 
Step 7.  Image placeholders will now appear in the place of actual 

images, along with alt text. Note any placeholders that do not 
contain alt text. 

 
Step 8.  Repeat Steps 6 and 7 for each page on the Web site. 
 
Test #3: Ensure that text is readable at larger sizes. 

Web surfers with low vision often set their Web browsers to display online 
text at larger sizes. To ensure that these visitors can read all site copy, 
enlarge text on a page to Larger and Largest sizes to check for 
inconsistencies or problems. To do this: 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Type the URL of the Web page you wish to test. 
 
Step 3.  Click the View menu item. A drop-down menu appears. 
 
Step 4.  From the drop-down menu, select the Text Size menu item. A  
              small window appears, listing five text-size options.  
 
Step 5.  Click the Larger menu item. Scan the site to ensure that all text is  
              readable and is not obscured by images or misaligned. Note  
              any problems. 
 
Step 6.  Click the Largest menu item. Scan the site to ensure that all text is  
              readable and is not obscured by images or misaligned. Note  
              any problems. 
 
Step 7.  Repeat Steps 5 and 6 for each page on the Web site. 
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Test #4: Ensure that site does not scroll horizontally. 

Visitors with limited mobility or ergonomic issues must be able to view a 
Web site with minimal movement. To ensure all text and images fit on the 
screen, check to see that the site scrolls vertically instead of horizontally. 
To do this: 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Type the URL of the Web page you wish to test. 
 
Step 3.  Look across the bottom of the browser window; no horizontal  
              scrollbar should appear. If you see one, make a note of it. 
 
Step 4.  Resize the browser window by clicking the Maximize/Restore Down  
              icon, located in the browser's extreme upper-right corner. (This 

icon looks like two boxes, one superimposed over the other.) Look  
              across the bottom of the browser window; again, no horizontal  
              scrollbar should appear. If you see one, make a note of it. 
 
Step 5.  Repeat Steps 3 and 4 for each page on the Web site. 
 
Test #5: Ensure that site is navigable with keyboard. 

Visitors with limited mobility or ergonomic issues may use the keyboard 
instead of a mouse to navigate a Web site. To ensure that all links and 
forms are accessible using a keyboard, try navigating the site using the 
Tab key. To do this: 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Enter the URL of the Web site you wish to test. 
 
Step 3.  Starting at the upper-left corner of the page, navigate the site 

using the keyboard's Tab key. Each time you press the Tab key, the 
browser should highlight a link or a form field. Navigate through 
the page with the Tab key, making sure that all forms and links are   

              accessible in the proper sequence. Note any problems. 
 
Step 4. Repeat Step 3 for each page on the Web site. 
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Test #6: Ensure that site has proper color contrast. 

Visitors who are color-blind may not be able to view all colors on your site. 
To ensure that such visitors can view all text and images, test your site in 
grayscale (black-and-white) mode. To do this: 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Enter http://graybit.com/main.php into Internet Explorer's address  
              bar. A Web page named GrayBit v1.0 appears. 
 
Step 3.  On the left side of the screen, the following text appears: GrayBit  
              v1.0 Input Form Enter a Web Page URL. Immediately below it, a              
              gray input form containing the text http://accessites.org appears.               
              Delete this text and enter the URL of your organization's Web site. 
 
Step 4.  Click the button labeled Make It gray. Your site appears in  
              grayscale in the browser window. 
 
Step 5.  Check to make sure that all text on your site is legible and that all  
              images are visible. Note any problems. 
 
Step 6.  Repeat Steps 2 through 5 for each page on the Web site. 
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B. Audio Accessibility Test 

To ensure that screen readers properly convey your Web site's text in 
audio form, test your site using Freedom Scientific's Job Access With 
Speech (JAWS), one of the most popular screen readers on the market.  
 
Note that while a full version of JAWS starts at $895, this tutorial focuses on 
testing with the trial version, which lasts for six months and can only be 
used for 40 minutes at a time. Also note that this tutorial focuses on 
downloading, installing, and using JAWS version 8.0 or later; instructions 
may vary if using an older or future version of the software. 
 
Editor's Note 2: In the future, version numbers and dates listed in the 
following instructions are likely to change. 
 
1. Download JAWS 

First, download JAWS. 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Type http://www.freedomscientific.com/fs_downloads/jaws.asp into 
              Internet Explorer's address bar. The JAWS For Windows Software  
              Download Page appears. 
 
Step 3.  Scroll to the Demonstration Versions Of Jaws subheading. Click the link labeled 

Free DEMO of JAWS 8.0 for Windows XP/2000 (50 MB - HTTP download).  
 
Step 4.  Scroll to the Demonstration Versions Of Jaws subheading. Click the link 
              labeled Free DEMO of JAWS 8.0.422 for Windows XP/2000 – November 
               2006 (50 MB – HTTP Download). A dialog box appears prompting you 
              to save the file.  

Step 5. Click the Save icon. A window titled Save As appears. 

Step 6.  In the Save As window's left navigation area, click the 
              Desktop icon. Click the Save icon in the window's lower-right   
              corner. A window appears, and JAWS begins to download. Since 
              the file consumes a large 50 MB, completing the download may 
              take a significant amount of time, depending on the speed of       

 your Internet connection. 
 
Step 7.  After JAWS downloads, the message Download Complete appears.     
              Click the Close icon. 
 
 

http://www.freedomscientific.com/fs_products/software_jaws_http_dnld.asp
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2. Install JAWS 

Next, install JAWS. 
 
Step 1.  Dispaly the computer’s Desktop view.   
 
Step 2.  Double-click the icon labeled J8.0.423U_ILM.exe. A screen titled      
              JAWS Setup Package appears. 
 
Step 3.  Click the Next icon. A message appears stating that JAWS is 
              configuring your system. 
 
Step 4.  A window appears stating that JAWS has made changes that 
              require you to start your computer. Close all open windows, and 
              click the OK icon. 
 
Step 5. Your computer will automatically shut down and restart. Upon 

restart JAWS prompts you to wait for several minutes will it makes 
changes to your system. 

 
Step 6. A window labeled Welcome to the JAWS 8.0 Setup Wizard appears. 
             Click the Next icon. 
 
Step 7. A window labeled End User License Agreement appears. Carefully 
             read the text in the window and click the box labeled I accept the 
              terms found in the License Agreement. Click the Next icon. 
 
Step 8. A window labeled Choose Setup Type appears. Click the Typical 
              icon. 
 
Step 9.  A window labeled Ready To Install appears. Click the Install 
               icon. 
 
Step 10. After JAWS finishes installing, a window labeled JAWS 8.0 has been   
                successfully installed appears. Click the Finish icon. JAWS will 
               immediately launch. 
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3. Use JAWS 

Now you can use JAWS to read your organization's Web site. 
 
Step 1.  Once JAWS launches a window labeled Activation appears. Since 
              this window applies only to users who have purchased the full 
              version of JAWS, close it by clicking the red X in the window's 
              upper-right corner; the demo will still function. 
 
Step 2.  Open Internet Explorer. 
 
Step 3.  Enter your site's URL in the address bar. 
 
Step 4.  JAWS begins speaking the content of your home page, starting by 
              reading its title and disclosing how many headings and links are 

on the page. 
 
Step 5.  Allow JAWS to read through the entire page; note any problems    
              the application encounters when reading frames, tables, forms,                
              links, and text. 
 
Step 6. Repeat Steps 3 through 5 with each page found on your site. 
 
Editor's Note 3: To get a more complete understanding of all of JAWS' 
features, you should consult the application's documentation. To access 
JAWS' documentation, click the Start menu, select the Programs menu 
item, then scroll down and select the JAWS 8.0 option. From the drop-
down menu, select the Explore JAWS option, then click Explore The 
Manuals. From the window that appears select either the file labeled 
JAWS Quick Start Guide.doc or the file labeled JAWS Quick Start Guide.pdf 
(requires Adobe Acrobat Reader).  
 
Editor's Note 4: After 40 minutes, the trial version of JAWS requires you to 
restart your computer before you can resume testing.
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III. Back-End Web Accessibility Testing 

After performing the front-end accessibility tests described in Section II of 
this document, test the site's HTML code to ensure there are no errors that 
could create accessibility problems. This section provides step-by-step 
instructions for using the WAVE accessibility tool to locate accessibility 
errors. 
 
1. Submit the site to WAVE 

To submit your site to WAVE: 
 
Step 1.  Open Internet Explorer. 
 
Step 2.  Type http://www.wave.webaim.org into Internet Explorer's    
              address bar. The WAVE home page appears. 
 
Step 3.  Type the site's URL in the field labeled Enter the URL here. Click the  
              Submit icon. Your site appears in the browser window. 
 
Step 4.  If your site now displays numbered symbols, save an HTML version 

of the page for later reference. Create                
              a new folder on your computer's desktop by right-clicking   
              anywhere, choosing New from the menu that appears, and                
              clicking Folder. Name the folder WAVE_Tested_HTML_Files. 
 
Step 5.  In Internet Explorer, click the File menu item and select Save As. In 

the Save As window's left navigation area, click the Desktop icon 
and double-click the WAVE_Tested_HTML _files folder. In the Save 
As window's first drop-down menu, type the desired filename. 
From the second drop-down menu, select Web page, complete 
(*.htm, *.html). Click the Save icon. 

 
Step 6. Repeat Steps 1 through 5 with all pages on your site. 
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2. Translate WAVE's error symbols 

To translate WAVE's error symbols: 
 
Step 1. Numbered symbols on a Web page submitted to WAVE indicate   
             possible errors in the HTML code. The examples below illustrate  
             several accessibility errors detected by WAVE: 
 

Symbol Meaning 
 

   

Indicates that an HTML frame lacks a title. 
Therefore, the table will lack meaning to visitors 
who read the site's content using a screen reader. 

 

   

Indicates that the Web site contains a JavaScript-
based form that automatically submits itself when a 
visitor selects an option from a drop-down menu. 
Since visitors who do not use a mouse may find this 
type of form difficult to use, you'll need to place a 
"Submit" icon next to the form. 

 
Step 2. Enter http://www.wave.webaim.org/wave/explanation.htm into   
             Internet Explorer's address bar to bring up the Index of  
             WAVE icons page, which explains the meaning of all the error                
             symbols. Note all detected errors. 
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IV. Next Steps 

The tests covered in this tutorial should help you detect high-level 
accessibility issues found on your organization's Web site. After completing 
these tests, contact a professional Web-development consultant or 
volunteer to help your organization fix the problems you find.  
 
Once you fix the site's major accessibility problems, you may choose to 
delve a little deeper into the world of accessibility. To read the full text of 
the WCAG 1.0, open Internet Explorer and enter http://www.w3.org/TR/WCAG10/ 
into the address bar. 
 
Making your Web site accessible to everyone who visits increases your 
organization's online reach, giving you the opportunity to attract more 
volunteers, donors, and members. Because no matter what cause your 
organization supports, gaining more resources is always a good thing. 
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